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1 Introduction

As one of only two native English speakers at my workplace, I am fre-
quently called upon to proofread and correct scientific and technical articles
written by my German colleagues. Over time I have noticed that certain
types of errors tend to occur particularly frequently; oftentimes these mis-
takes can be traced to a misapplication of German writing rules to English.
I have therefore prepared this short guide to English technical and scien-
tific writing directed specifically to German speakers. It addresses common
translation problems plus some important differences between German and
English punctuation and diction. I have also endeavoured to indicate some
differences in usage between American and British English.

The reader should note that the descriptions and recommendations pre-
sented in this document are not meant to be taken as the final word on
what is correct. Like every other language, English is largely arbitrary and
is constantly changing and evolving. What may be an inviolable rule to one
writer may be bendable to another, and may be completely wrong to yet
another writer. When in doubt as to which style to use, consult your pub-
lisher or the style sheet he or she has provided. If you are self-publishing,
as on a web page, then what style you adopt is not so important as simply
choosing one style and applying it consistently.

2 Punctuation, spacing, and general typography

There are a number of important differences between punctuation as used
in German and as used in English. In particular, there are a few punctua-
tion marks which exist in English but not in German. Table 1 summarizes
possibly unfamiliar English punctuation and indicates how to produce each
symbol in LATEX, HTML, and Microsoft Word.

2.1 Ampersand

The ampersand (&) means “and”, but only in the context of company names
and lists of authors. In all other contexts the word “and” should be spelled
out in full.

Incorrect Correct

We programmed in C & Java. We programmed in C and Java.

2.2 Comma

In English the use of commas (,) is largely a matter of personal style. How-
ever, it is never correct to put a comma before a subordinating clause intro-
duced by a subordinating conjunction, or between two main clauses.
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Symbol Name LATEX HTML Word

— em-dash --- &mdash; Ctrl+Alt+Num -
– en-dash -- &ndash; Ctrl+Num -
- hyphen - - -
− minus sign $-$ &minus; Equation editora

× times symbol $\times$ &times; Alt+0215
“ ” double quote marks ‘‘ ’’ <q> </q>b " "c

‘ ’ single quote marks ‘ ’ <q> </q>b ’ ’c

& ampersand \& &amp; &
. . . ellipsis \ldots &hellip; Ctrl+Shift+.
£ pounds \pounds &pound; Alt+0163
¢ cents \textcentd &cents; Ctrl+/, C
§ section symbol \S &sect; Insert→Symbole

¶ pilcrow symbol \P &para; Insert→Symbole

| | non-breaking space ~ &nbsp; Ctrl+Shift+Space
| | thin space \, &thinsp; Insert→Symbole

aWord provides no facility to enter this symbol outside the equation editor. However,
many people choose to substitute the en-dash for the minus sign in running text, in which
case it should be surrounded by thin space.

bAccording to the HTML 4.0 standard, the <q> element produces quotation marks
appropriate for the document’s given language. However, support for this element is
poorly implemented in many browsers. For this reason most people choose to use single
or double tick marks (’ ’ or " ") instead when writing English.

cIn its default configuration, Word should convert single and double tick marks to
proper quotation marks. In the English version it may be necessary to turn on the “Smart
quotes” feature from the Tools→AutoCorrect dialog.

dRequires the textcomp package.
eBy default Word does not bind a keystroke combination to this symbol. However, it

is possible to add your own custom keystroke combination in the Insert→Symbol dialog.

Table 1: English punctuation

Incorrect Correct

I know, that he’ll come. I know that he’ll come.
Our method has been criticized, despite
this we will continue to improve it.

Our method has been criticized; despite
this, we will continue to improve it.

Many writers prefer to put a comma before the last item in a list. This of-
ten helps disambiguate confusing or unintendedly humorous juxtapositions.

Ambiguous Unambiguous

We ate eggs, ham, peanut butter and
fish sandwiches.

We ate eggs, ham, peanut butter, and
fish sandwiches.

2.3 Ellipsis

The ellipsis (. . . ) is used to indicate text omitted from a quotation. In
scientific writing it should not be used to indicate a pause or to terminate
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lists as a substitute for “etc.” Note that the ellipsis is its own symbol; it is
more widely spaced than three periods (...).

Julius Caesar once said, “I came, . . . I conquered.”

2.4 Emphasis

To indicate emphasis in English, use italicized text (see §2.7). Indicating
emphasis with all-uppercase, underlining, boldface, or quotation marks are
all hold-overs from the days of typewriters and should never be used with
modern word processors and other document preparation systems. Also,
the older German practice of increasing interletter spacing (l i k e t h i s) is
never used in English.

2.5 Exclamation mark

Use of the exclamation mark (!) is considerably more restricted than in
German. Do not use the exclamation mark for commands unless you mean
to indicate that they are shouted.

2.6 Hyphen, minus sign, and dashes

In German, there are only two forms of dashes: the short Bindestrich or Di-
vis, and the longer Gedankenstrich (also called Halbgeviertstrich or Von-Bis-
Strich). In English orthography, there is an important four-way distinction
among such horizontal lines:

� The em-dash (—) is a long dash, about the width of an uppercase M,
and is used to set off parenthetical comments.

Early computerized writing assessors focused on mechanical
properties—grammar, spelling, punctuation—and on simple stylistic
features.

Whether to insert space around em-dashes is a matter of style. If you
do insert space, however, be sure that a line never begins with a dash.
You can ensure this by using a non-breaking space before the dash and
a regular space after the dash.

� The en-dash (–) is a medium dash, about the width of an uppercase
N, and is used to specify ranges, or for compounds of names or other
words of the same part of speech. In these cases, there is never any
space around the en-dash.

Flavius XVII (1327–1409) was a fictional pope.

The Church–Turing thesis has nothing to do with
minimum–maximum problems.

5



Many British printers use an en-dash with surrounding space where
American printers would use an em-dash. This is closer to the German
usage of the Gedankenstrich.

Early computerized writing assessors focused on mechanical
properties – grammar, spelling, punctuation – and on simple
stylistic features.

Again, ensure that a line never begins with an en-dash by making the
leading space non-breaking.

� The hyphen (-)—technically not a dash—is a very short horizontal line
used to join words of different types, or prefixes to stems.

� In proper typesetting, the minus sign (−) is distinct from the hyphen
and en-dash; it is used only to indicate subtraction and negative num-
bers.

2.7 Italics

Italics are used for emphasis, and also to set foreign terms (including German
words). Whether to italicize commonly-used Latin abbreviations is a matter
of personal preference.

We had a tête-à-tête at the Deutsche Bahn headquarters.

2.8 Multiplication symbol

To indicate multiplication or scaling, use the multiplication symbol (×), or
spell out the appropriate word, such as “by” or “times”. The asterisk (*)
and the lowercase x are incorrect in this context.

Incorrect Correct

The screen resolution was 640x480. The screen resolution was 640×480.
The hole measured 15 mm * 27 mm. The hole measured 15 mm by 27 mm.

2.9 Quotation marks

In technical writing, double quotation marks (“. . .”) always come in pairs.
They look like miniature versions of the numbers 66 and 99 and are always
printed at the top of the line. German-style quotation marks (� . . .“ or
�. . .�) are always incorrect, as are double tick marks (". . . "). (The latter
should be used only in monospaced fonts and in program code.) In American
English, double quotation marks are used for the following purposes:

� to report speech

“You’ve all done very well,” he said.
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� to indicate questionable or idiosyncratic usage

We can think of x as a sort of “pseudo-pointer”.

� to set the names of articles in journals and magazines

“C99: a novel approch to text segmentation” was published in the
Journal of Artificial Intelligence.

In British English, single quotation marks (‘. . . ’) are usually used instead
of double quotation marks for the above purposes.

The following uses of quotation marks are incorrect :

� to set section titles in a paper

Incorrect Correct

“Results” Results

� for emphasis

Incorrect Correct

Albert Einstein was a “very” impor-
tant physicist.

Albert Einstein was a very important
physicist.

2.10 Quotations

Short quotations from third parties should be set in single or double quota-
tion marks as described in §2.9. For quotations longer than a couple lines
of text, do not use quotation marks, but rather widen both margins for the
entire quotation:

Bertrand Russell, the notable British philosopher and mathematician, is
rumored to have remarked,

[The] kind of philosophy that I value and have endeavoured
to pursue is scientific, in the sense that there is some definite
knowledge to be obtained and that new discoveries can make
the admission of former error inevitable to any candid mind.
For what I have said, whether early or late, I do not claim the
kind of truth which theologians claim for their creeds. I claim
only, at best, that the opinion expressed was a sensible one to
hold at the time.
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2.11 Section and paragraph symbols

In English, § is used to refer to numbered sections, whereas ¶ is used to refer
to numbered paragraphs. Note that this is the reverse of most European
usage. When referring to multiple sections or paragraphs, the symbols §§

and ¶¶ are used. Unlike in German, it is not usual to insert a space between
the symbol and the number.

Please refer to the results in §4.3.1.

This theory is discussed in §§8–12.

2.12 Slash

Slashes (/) are used to specify alternation, and to separate numbers in
numerically written dates. Note that there is no space around a slash.

Incorrect Correct

I want a cat and / or a dog. I want a cat and/or a dog.

3 Numbers, time, and measurements

3.1 Numbers

In informal writing, the period or full stop (.) is used as the decimal point
and the comma (,) is used as the thousands separator for numbers to the
left of the decimal point. In scientific writing it is permissible to follow the
SI convention and use a thin space as the thousands separator for digits to
the left or right of the decimal point.

Incorrect Correct

1.234.567,890 1,234,567.890
1234567.890 1 234 567.890

American and British English have different vocabularies for describing
powers of ten; the first few terms are summarized in Table 2. Confusingly,
there is currently a trend in British English to adopt the American usage. To
avoid ambiguity many writers always use the unambiguous term thousand
million for 109. For higher powers of ten, it is usually best in scientific
writing to write the number numerically in scientific notation.

3.2 Dates

In American English the day is written after the month and is separated
from the year with a comma. In British English the day is written before
the month; unlike in German, there is no period following the day. It neither
case is it necessary to write the ordinal after the day (e. g., 3rd June, August
12th). Also, it is rare to prefix a 0 to single-digit days and months.
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American British power of 10

million million 106

billion milliard, thousand million 109

trillion billion 1012

quadrillion thousand billion 1015

quintillion trillion 1018

Table 2: English names for powers of 10

When the entire date is written out numerically, the slash (/) is usually
used as a separator. Less commonly one sees hyphens (-) or en-dashes (–
); unlike in German, periods (.) are never used. In scientific writing it is
permissible to format numeric dates as per the ISO 8601 standard1—i. e.,
YYYY–MM–DD, with leading 0s in the case of single-digit days and months.
This format is especially appropriate when addressing an international au-
dience which may contain both British and American readers.

� American English

July 6, 2004

7/6/04

� British English

6 July 2004

6/7/04

� ISO

2004–07–06

Traditionally the abbreviations B.C. (Before Christ) and A.D. (Anno
Domini) were used to refer to dates before and after the beginning of year
1, respectively. However, the modern trend in secular writing is to use the
religion-neutral terms B.C.E. (Before Common Era) and C.E. (Common
Era). Both abbreviations follow the year. These religion-neutral terms
do not carry the social stigma some Germans feel accompany use of the
equivalent v.u.Z. and u.Z.

The science of information retrieval began in 543 B.C.E., when. . .

1http://www.cl.cam.ac.uk/~mgk25/iso-time.html
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3.3 Time

The 24-hour clock is not widely understood in American English, but it
should be acceptable for scientific writing. As per ISO 8601, separate hours,
minutes, and seconds with a colon (:). Do not use a period (.) as was
formerly specified by DIN 5008 before May 1996.

The experiment was concluded at 23:59.

3.4 Currency

For currencies with their own special symbols, the symbol generally comes
before the amount, with no intervening space. If the currency has no symbol,
use the standard ISO 4217 abbreviation2 instead. In running text it is also
permissible to write the name of the currency out in full after the amount.

� $10,345.88

� £10,345.88

� c10,345.88

� NOK 10,345.88

� 10,345 Norwegian Krone

Subdivisions of currencies, such as the abbreviation for pence (p) and the
symbol for cents (¢), come after the amount.

We estimate a cost of 15¢ per user.

Volunteers were paid 27p per word.

Note that it is incorrect to use a dash (—) to indicate an exact figure:

Incorrect Correct

c10,345.— c10,345.00

3.5 Measurements

In scientific writing, format measurements as per SI guidelines3.

4 Diction

4.1 Abbreviations

With a few exceptions, English generally uses Latin for commonly-used tech-
nical abbreviations. Those most commonly seen in scientific writing are sum-
marized in Table 3. Traditionally, Latin abbreviations have been printed in

2http://www.xe.com/iso4217.htm
3http://www1.bipm.org/en/publications/brochure/
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Abbreviation Expansion Meaning German term

A.D. anno domini in the year of our lord n.Chr.
B.C. before Christ before Christ v.Chr.
B.C.E.a before common era B.C. v.u.Z.
c., ca.b circa about ca.
C.E.a common era A.D. u.Z.
cf.c confer compare with vgl.
e. g.d exempli gratia for example z. B.
et al. et alia and others et al.
etc. et cetera and so on usw.
ff.c folios and the following (pages) f., ff.
ibid.e ibidem same as previous reference a. a.O.
i. e.d id est that is d. h.
N.B. nota bene note well N. B.
p. page page S.
pp. pages pages S.
q. v.c quod vide see elsewhere s. d.
viz. videlicet namely nämlich, d. h.
vs. versus versus im Vergleich zu

aOften preferred to B.C. and A.D. in secular writing.
bNormally used only with dates.
cNormally used only inside parentheses.
dNormally used outside a main clause and followed by a comma.
eNormally used only in footnotes and endnotes.

Table 3: Abbreviations used in English

italics, though many publishers now prefer to set them in standard roman
type. As with their German analogues, there is a thin space after the first
periods in e. g., i. e., N.B., and q. v.

Be careful not to overuse Latin abbreviations, or you will come across as
stuffy and pretentious. For instance, instead of using i. e. several times in a
row, try substituting “that is”, “that is to say”, “in other words”, “namely”,
etc.

4.1.1 c., ca.

As in German, c. and ca. mean “about” or “around”. However, it is unusual
in English to use them, or their expanded form circa, for anything other than
dates. For measurements and other contexts, it is usually better to write
“about”, “around”, or “approximately”.

4.1.2 cf.

The abbreviation cf. means “compare”, not “see there” or “for example”.
It should be used only when you wish to indicate a distinction (or, more
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rarely, a similarity) between something you have just said and something
you are referencing.

Incorrect Correct

There are several functional languages
(cf. Lisp).

C is an imperative language (cf. Lisp,
which is functional).

4.1.3 e. g. and i. e.

Many publishers prefer that the abbreviations e. g. and i. e. be followed by a
comma, since a comma would usually be necessary had the expanded forms
“for example” or “that is” been used. Unlike in German, it is extremely rare
for these abbreviations to be used in a main clause; they should generally
be set off from the main sentence using parentheses, a semicolon (;), or an
em-dash (—). In main clauses it is more common to spell out “for example”
and “that is”, or use some alternative wording.

Incorrect Correct

If we had used, e. g., a bubble sort, the
program would be slower.

If we had used, say, a bubble sort, the
program would be slower.

We used a better sort instead, i. e., one
with O(n log n) time.

We used a better sort instead—i. e., one
with O(n log n) time.

4.2 Translation problems

4.2.1 bzw.

The German term beziehungsweise or bzw. translates into English literally
as “respectively”, though in practice a word-for-word translation is almost
never appropriate. In the majority of cases, bzw. translates simply as “or”,
and sometimes as “and” or “and/or”. When it is absolutely necessary to
emphasize the order of the things, the word “respectively” can be used, but
since it is not a conjunction, it is always in a different sentence position from
the German bzw.

German English

Bitte drücken Sie den Knopf 1 oder 2,
wenn Sie in den 1. bzw. 2. Stock fahren
moechten.

Please press button 1 or 2 if you want
to go to the first or second floor.

Sie können uns anrufen bzw. unter der
folgenden Adresse postalisch erreichen.

You can contact us by phone and/or
write to the following address.

Äpfel und Birnen kommen in den ersten
bzw. zweiten Eimer.

Apples and pears go into the first and
second bucket, respectively.

4.2.2 since vs. for

When speaking of past events, the preposition since is used in respect to a
fixed point in time, whereas for is used for durations.
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Incorrect Correct

We have been working on the project
since five years.

We have been been working on the
project for five years.

5 Resources

Besides this guide, there are a number of other useful resources for writing
or translating into English.

5.1 Style guides

As mentioned in the introduction to this paper, it is very likely that the
publisher to whom you are submitting your writing has specified a certain
style guide to use. Such a guide usually indicates which variant of English
to use (American vs. International); how to format citations, footnotes, end-
notes, figures, and tables; and how to prepare your manuscript for printed or
electronic submission. The guide may be written by the publisher himself,
or he may simply refer you to one of the standard style guides used in aca-
demic writing. (The latter category includes the Chicago, MLA, and APA
styles, for which printed books and online summaries are available.) Always
follow the prescribed style guide, even if it contradicts this paper, another
English guide, or your personal preferences or notions of what is “correct”.
A style guide does not exist to ensure correctness, but rather consistency.
Consistency in spelling, punctuation, capitalization, and abbreviations en-
hances any publication; inconsistencies are distracting for the reader and
reflect poorly on both the author and the publisher.

5.2 Books

� Robert Schoenfeld. The Chemist’s English. John Wiley &
Sons, 3rd revised edition, 1989. ISBN 3527280030
Schoenfeld, longtime editor of the Australian Journal of Chemistry,
wrote an article, “Say It in English, Please!” primarily for German-
speaking chemists. It is reprinted as the final chapter in this book.

� William Strunk, Jr. and E. B. White. The Elements of
Style. Pearson Higher Education, 4th edition, 2000. ISBN
020530902X
This important handbook has been used by writers for nearly a hun-
dred years. It covers the basic rules of English usage and principles of
composition.

� Henry Fowler. A Dictionary of Modern English Usage. Ox-
ford Language Classics Series. Oxford Press, 2nd revised edi-
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tion, 2003. ISBN 0198605064
This is another venerable usage guide which covers grammar, syntax,
style, and word choice. Many different versions and editions are avail-
able.

5.3 Online writing guides

The alt.usage.english FAQ links to a number of online writing and gram-
mar guides. The full list can be found at http://alt-usage-english.org/
intro_b.shtml#WritingandGrammarGuidesOnLine.

5.4 Online bilingual dictionaries

You can find more online English–German and/or German–English dictio-
naries besides the ones listed here at these Open Directory Project pages:

� http://dmoz.org/Reference/Dictionaries/World_Languages/G/
German/

� http://dmoz.org/World/Deutsch/Wissen/W%c3%b6rterb%c3%
bccher/Sprachen/Englisch/

5.4.1 General-purpose

� LEO English–German Dictionary
http://dict.leo.org/

5.4.2 Archæology

� Excavation Dictionary
http://ausgraeberei.de/woerterbuch/

5.4.3 Computing

� Queen Mary, University of London’s English–German Dictionary of
Common Computing Terms
http://www.css.qmul.ac.uk/foreign/eng-german.htm

5.4.4 Engineering

� German–English Dictionary of Railway or Technical Terms
http://worldrailfans.org/Germany/Dictionary.shtml

5.4.5 Libraries, books, data processing

� Birgit Wiegandt’s Bibliotheks-Glossar
http://www.bibliotheks-glossar.de/
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5.4.6 Mathematics

� Rainer Baule’s Mathematisches Wörterbuch
http://www.math.uni-goettingen.de/baule/wbuch.html

5.4.7 Organic chemistry

� Beilstein Dictionary
http://www-sul.stanford.edu/depts/swain/beilstein/
bedict1.html

5.5 Usenet

5.5.1 alt.usage.english

The newsgroup alt.usage.english is a forum for the discussion of how
particular words, phrases, and syntactic forms are used. The participants of
a.u.e. are generally very welcoming and pleased to answer questions from
non-native speakers on English usage. The newsgroup has its own dedicated
website at http://alt-usage-english.org/, which hosts a comprehensive
FAQ.

5.5.2 sci.lang.translation

sci.lang.translation is a forum for those translating from one language
into another. While the group was founded mostly for discussion of trans-
lation tools and education for professional translators, translation requests
for difficult or unusual technical terms or short passages are also considered
on-topic. To maximize the chances of a speedy reply, be sure to include in
your article’s subject header the source language, destination language, and
a brief summary of the translation problem. For example:

Subject: DE>EN "Küß die Hand, schöne Frau"

The group’s FAQ is available at http://www.faqs.org/faqs/language/
translation-faq/.

5.6 Search engines

When in doubt as to which of two or more English phrases is “correct”,
Google or another search engine may be able to provide the answer for you.
For example, there is a common English idiom which means to talk without
actually telling the main point. Say you can’t remember whether it is to
“beat around the bush” or to “beat the bush around”. A Google search for
the former yields 42 700 results, while the latter gets only 9. It’s therefore
more likely that the former phrase is the one you intended—indeed, this can
be verified by examining some of the results to see if the phrase is being
used in the manner you expected.

15

http://www.math.uni-goettingen.de/baule/wbuch.html
http://www-sul.stanford.edu/depts/swain/beilstein/bedict1.html
http://www-sul.stanford.edu/depts/swain/beilstein/bedict1.html
news:alt.usage.english
http://alt-usage-english.org/
news:sci.lang.translation
http://www.faqs.org/faqs/language/translation-faq/
http://www.faqs.org/faqs/language/translation-faq/


6 Acknowledgments

The author extends his sincere gratitude to all those on Usenet who con-
tributed useful criticism and suggestions.

16


	Introduction
	Punctuation, spacing, and general typography
	Ampersand (&)
	Comma (,)
	Ellipsis (…)
	Emphasis
	Exclamation mark (!)
	Hyphen, minus sign, and dashes (- - -- ---)
	Italics
	Multiplication symbol ()
	Quotation marks (`' ``'')
	Quotations
	Section and paragraph symbols (§ ¶)
	Slash (/)

	Numbers, time, and measurements
	Numbers
	Dates
	Time
	Currency
	Measurements

	Diction
	Abbreviations
	c., ca.
	cf.
	e.g. and i.e.

	Translation problems
	bzw.
	since vs. for


	Resources
	Style guides
	Books
	Online writing guides
	Online bilingual dictionaries
	General-purpose
	Archæology
	Computing
	Engineering
	Libraries, books, data processing
	Mathematics
	Organic chemistry

	Usenet
	alt.usage.english
	sci.lang.translation

	Search engines

	Acknowledgments

